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This is the age of computers. Computer is undergoing rapid 
change, and new and improved technological advances appear 
almost daily. Computers have invaded all walks of life to such an 
extent that computer literacy has become the order of the day.  
Computer  science is now an essential addition to the school curriculum at all 
levels. 

Computer Zone is a series of ten books on Computer Science for school level, 
designed for the new generation of students who need to acquire knowledge 
on the theory, application and programming aspects of computing. Logical 
and scientific in its approach, the series covers the history of computer, its 
accessories, applications and programming in a step-by-step and graded 
manner. It has been prepared to focus on creativity and encourage young 
children to explore and experiment with learning opportunities.

This book is the fifth in the series and is recommended for use in class 5. 
The chapters are supplemented with lucid illustrations, practise exercise, brief 
summaries and a variety of theory and lab exercises, that ensure mastery 
over the concepts learnt.

A lot of research and meticulous attention to detail have gone into the making 
of this book. However, there is always scope for improvement. Constructive 
criticism and suggestions which could be incorporated in the future editions of 
this book, are welcome in  my mailing address hari99_sapkota@yahoo.com.

I earnestly hope that the students would find the journey through this series 
an enjoyable experience and gain a sound working knowledge on the 
basic aspects of computing that lay the foundation for good and systematic 
programming. 

-Author
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1Computer Zone - Book 5

a.	 Define computer and explain the importance of a computer system.
b.	 Differentiate between data and information.
c.	 Explain the four basic functions of a computer system and identify the important functional parts 

of a computer system.
d.	 Explain the features of a computer.
e.	 Identify and explain the different types of modern computers.

Chapter1
Introducing

Computer System
Learning Objectives

An  Overview
The computer is one of the most brilliant gifts of science. Computers are 
constantly being updated to make out lives better. In fact, the computer is 
a wonderful electronic brain that we have come to rely on, in our everyday 
life. The computer has proved a friend and servant of science, technology 
and industry. Most offices, shops, factories and industries use computers. 
Computer is the backbone of information technology whose major 
application lies on the Internet. Internet has some very useful applications 
in our day to day life. The computer gives us many benefits. Eventually, 
computers come into every family and effectively influence our usual life. 
Thus, computer has become an indispensable part of our daily life. The 
computer is a boon to every human beings.
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Data
Data refers to a collection of raw facts and figures. Data consists of letters, 
numbers, sounds, or images. It does not provide any meaning and need to be 
worked upon.

Information
The result obtained by processing is called information. Information is the data 
that have been shaped by humans into a meaningful and useful form. 

Computer System

Computers are extremely important in the 
modern world of today. In the fast moving life 
of the modern world of today, computers hold 
tremendous significance in every fields. It is very 
hard to imagine modern life without computer. 
A computer system is one that is able to take 
a set of inputs, process them and create a set 
of outputs. This is done by a combination of 
hardware and software. 

The computer system has one or more inputs to provide data. This data is 
then processed in some way. The outcome of the processing is sent to an 
output or it may be stored until some event happens to cause it to be output.

Input Processing Output

For processing to take place, there needs to be a set of instructions of what 
needs to be done. This set of instructions is called a program.
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Parts of a Computer System

The four basic functions of a computer are input, processing, output and 
storage. Input is the information which is entered into the computer. 
Processing is performing operations on or manipulating data. Output is the 
result of the data processing. Storage refers to saving of information for 
later use. The computer consists of input devices, processing device and 
output devices, storage devices for performing these functions.

Input Devices Processing Device Output Devices

Storage Devices

Input Devices
Input devices are devices used to input data or information into a computer. 
They are like your sense organs (ears, eyes, tongue, skin and nose) which take 
in information and send it to your brain. The most common input devices are 
keyboard and mouse. 	  
The functions of input devices are:
a. 	 accept instructions and data
b. 	 convert these data and instructions to the form acceptable to the computer
c. 	 supply the data and instructions to the processing unit of the computer 

system
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Processing Device
The data entered is processed by the processing device according to the 
instructions given by the user. The processing device in a computer is called 
the Central Processing Unit. The Central Processing Unit (CPU) carries out 
the processing of data. It is the centre of all processing activities. Therefore, 
it is called the brain of the computer. 
The CPU has three main parts: 
a.	 Arithmetic Logic Unit	 b.  Control Unit 		  c.  Memory Unit

Arithmetic Logic Unit
Arithmetic Logic Unit does all the arithmetic calculations like addition, 
subtraction, multiplication and division. It also makes comparisons of data, 
such as less than, greater than and equal to.

Control Unit
Control unit is the heart of the computer. The control unit is a component of 
a computer’s Central Processing Unit (CPU) which directs operation of the 
processor. It controls communication and co-ordination between input/output 
devices. It reads and interprets instructions and determines the sequence for 
processing the data.

Primary Memory
Primary memory is a storage location that holds memory for short period of 
time while the computer is running. It operates at a very high speed. It is also 
called internal memory or main memory. 
The primary memory of the computer system is of two types. They are: 
a.  Random Access Memory 			   b.  Read Only Memory

Random Access Memory (RAM)
RAM stands for Random Access Memory. It is also 
called read/write memory as information can be written 
into and read from RAM. It is used to store programs 
and data temporarily because anything stored in RAM 
is lost when the computer is switched off.
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Read Only Memory (ROM)
ROM stands for Read Only Memory. It can be used to perform only the read 
operation. Data were store in ROM at the time of manufac-turing. The data 
store in ROM is permanent in nature and is not loss even if the power supply 
is cut down. ROM is considered as non- vol-atile memory.ROM stands for 
Read Only Memory. It can be used to perform only the read operation. Data 
were store in ROM at the time of manufacturing. The data store in ROM is 
permanent in nature and is not loss even if the power supply is cut down. 
ROM is considered as non- volatile memory.

RAM ROM
a.  RAM stands for Random Access 

Memory
a. ROM stands for Read Only Memory

b.  RAM allows both read and write 
operation

b.  ROM allows only read operation

c.   It is volatile in nature i.e. data are loss 
when the power supply is cut off.

c.  It is non- volatile in nature

d.  It is used to store programs and data 
temporarily.

d.  It is a permanent memory.

Output Devices
Output devices are the devices used to display or output data which has been 
processed or has been stored on the computer. The most common output 
devices are monitor and printer.
The functions of output devices are to:
a. 	 convert the result produced by the computer after processing, into a form 

that we can understand.
b.	 display the converted results with the help of the output devices.

Facts Corner TYPEWRITER   is the longest word that you can type using the letters only on one row of 
the keyboard of your computer.
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Features of a Computer

We are living in the age of electronic revolution where computers are integral 
part of our life. It is indeed, difficult to imagine our daily life without their 
use in one way or other. Practically, computers have entered into each and 
every walk of life due to the following special features of computers: 

Speed
Computers work at enormous speed. Computers work with the help of 
electrical signals.  They perform millions of calculations in just a second.  

Accuracy
Computer is capable of performing calculation with 100% accuracy.  
They perform accurate calculations and give correct results according to 
the instructions fed to them. Errors that may occur can almost always be 
attributed to human error (inaccurate data, poorly designed system or faulty 
instructions/programs written by the programmer).

Diligence
Unlike human beings, computers are highly consistent. They do not 
suffer from human traits of boredom and tiredness resulting in lack of 
concentration. Computers, therefore, are better than human beings in 
performing voluminous and repetitive jobs. 

Storage capacity
Today’s computers can store large volumes of data. A piece of information 
once recorded (or stored) in the computer, can never be forgotten and can 
be retrieved almost instantaneously. Storage is done in the memory of a 
computer. The data and information are stored in the secondary memory 
such as hard disk, compact disk and pen drive. 
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Versatility
Computers are versatile machines, which can handle a large variety of jobs. 
They are used everywhere. We can see computers at shops, space stations, 
schools, etc. The power of a computer varies from place to place as per the 
requirement.

Reliability
Computer provides very high speed accompanied by an equality high level 
for reliability. Thus, computers never make mistakes of their own.

Programmability
The computer can be programmed to do all forms of activities of human 
beings. Programming in computer means the act of writing computers 
programs and this involves the use of special set of characters, signs 
and symbols to supply instruction to the computer for execution towards 
achieving specific tasks (motives). This opportunity gives room for the 
computer to be a versatile system.

Brainstorming 

  task
Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Data, Computer System, Primary Memory, Input device, Information

a.	 A __________________ is one that is able to take a set of inputs, 
process them and create a set of outputs.

b.	 ____________________refers to a collection of raw facts and figures. 
c.	 The result obtained by processing is called ____________________ .
d.	 ____________are devices used to input data or information into a 

computer.
e.	 _________________is a storage location that holds memory for short 

period of time while the computer is running.
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Modern Computers

The computers we use today are modern computers. They are very powerful. 
They are faster, cheaper and smaller in size than the earlier computers. 
Modern computers do calculations at very high speeds. Following types of 
modern computers are commonly in used.

Desktop computer
Desktop computer can be small, medium, or 
large in size and is placed on a desk. It can 
be either flatbed type or tower type. It is also 
called personal computer or PC because it is 
often owned and used by a single person.

Laptop
Laptops are battery or AC-powered personal 
computers that can be easily carried and used in 
different places. Laptop computer is expensive 
as compared to a desktop computer. It uses a 
keyboard, a small flat screen and a touch pad. 
It also has a hard disk, pen drives and a DVD-
ROM.

Palmtop
Palmtops are also called PDAs (Personal Data 
Assistant) or hand-held  computers or pocket 
computers. They are small enough to fit in 
your palm. It operates on batteries. It has to be 
plugged into a main computer for other uses. It 
uses a special pen and a touch-sensitive screen 
to enter data.	
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Data	 :	 A collection of facts and figures in raw 
format.

Information	 :	 The result obtained by processing.
Input devices	 :	 The devices used to input data or 

information into a computer. 
ROM	 ;	 A memory that holds a store of programs 

which tells the computer how to work.
Desktop	 :	 A computer that be small, medium, or 

large in size and is placed on a desk.
Laptop	 :	 The battery or AC-powered personal 

computers that can be easily carried and 
used in different places.

Tricky Terms 

Let 
Us Revise

•	 A computer system is one that is able to take a set of inputs, process 
them and create a set of outputs. 

•	 The four basic functions of a computer are input, processing, output and 
storage.

•	 Input devices are devices used to input data or information into a 
computer.

•	 The Central Processing Unit (CPU) carried out the processing of data.
•	 Arithmetic Logic Unit does all the arithmetic calculations like addition, 

subtraction, multiplication and division. 
•	 Primary memory is a storage location that holds memory for short period 

of time while the computer is running.
•	 Output devices are the devices used to display or output data which has 

been processed or has been stored on the computer.
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
 Control Unit, Laptop, Desktop, CPU, ALU

a.	 _____________________ carries out the processing of data.
b.	 _____________________ Computer can be small, medium or large in 

size and is placed on a desk.
c.	 _____________________ Computer is expensive as compared to a 

desktop computer.
d.	 ____________________  perform all the arithmetic and logical operation 

like addition, subtraction, equal to etc.
e. 	 _____________________ is the heart of the computer.

2.	 Match each term with the statement that best describes it.
ROM		  A collection of facts and figures in raw format.
Input devices		  The result obtained by processing.
Desktop		  The devices used to input data or information into a computer. 
Data		  A memory that holds a store of programs which tells the 

computer how to work.
Information		  A computer that be small, medium, or large in size and 

is placed on a desk.

3.	 Say whether these sentences are True or False.
a.	 The computer has proved a friend and servant of science, technology and 

industry.
b.	  Information is the data that have been shaped by humans into a meaningful 

and useful form. 
c.	 Output is the information which is entered into the computer.
d.	 Computers are versatile machines, which can handle a large variety of jobs.
e.	 Laptops are battery or AC-powered personal computers that can be easily 

carried and used in different places.
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4.	 Answer the following questions.
a.		 “The computer is one of the most brilliant gifts of science”. Explain this 

statement.
b.	 What is a computer system?
c.	 What are the difference between data and information?
d.	 What are the four basic functions of a computer system?
e.	 What is input device? State the functions of input device.
f.	 What is CPU? What are the three main parts of CPU?
g.	 Differentiate between RAM and ROM.
h.	 What is output device? State the functions of output device.
i.	 What is a laptop?
j.	 What is a palmtop?

5. 	 Write the full form of the following.
	 ALU		  CU		  CPU		  RAM		 ROM

Extrapolative Exercise
Name the following computer devices.
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a.	 Explain in short the developments of a computer.
b.	 List the features of an abacus.
c.	 Name the inventor of Napier’s bones and list the features of Napier’s bones.
d.	 List the features of difference engine and analytical engine.
e.	 List the features of Harvard Mark - I
f.	 List the features of Universal Automatic Computer-I

Chapter2
History of 

Computers
Learning Objectives

An  Overview
Computer is a versatile machine that can do arithmetic as well as non 
arithmetic calculation. The concept of counting started with the existence of 
human being. The early men lived nomadic and unorganized life. They felt 
no need of keeping records. But slowly when they started keeping animals 
and carrying on barter trade with other people, they needed a system to keep 
a record of the things. The early man used to count with the help of stones, 
pebbles, fingers, toes, sticks, etc. But the problem arose when the complex 
or big calculations are to be done. So, the need of some calculation devices 
arose that can help a men to do calculation easily and quickly. Let us look 
at some of the important developments, which lead to the present form of 
computers. 
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Chinese Abacus

Abacus was the first calculating device. 
It was first invented by Chinese in 
sixteenth century. It is the first known 
development in the world of calculating 
machines. It consists of a wooden frame 
having parallel wires with beads strung 
on them. It has two regions-heaven and 
earth separated by a mid-bar. There are 
two beads in the heaven and five beads 
on the earth. Calculations were done by 
sliding the beads towards the mid-bar.

Facts Corner The abacus is used in pre-schools as an aid in teaching numeral system.

Napier Bones

Napier bones are a set of rectangular rods marked with numbers on them. It 
was invented in 1617 by Scottish mathematician Sir John Napier. He also 
invented the system of Logarithm in 1614 AD which helped in arithmetic 
calculations. It was meant for calculations like multiplication and division 
of numbers. It also enabled the transformation of multiplication and division 
into simple addition and subtraction. The rod was made of bones with 
numbers on it.
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Slide Rule

William Oughtred, an English Mathematician invented Slide Rule in 1620 
AD. It was based on the principle that actual distance from the starting 
point of the rule is directly proportional to the logarithm of the numbers 
printed on the rule. It is a device consisting of two logarithmically scaled 
rules mounted to slide along each other so that multiplication, division, and 
other more complex computations are reduced to the mechanical equivalent 
of addition or subtraction.

Facts Corner Henry Coggeshall invented a 2 foot folding slide rule for lumber measure, called 
the Coggeshall slide rule in 1677.

Pascaline

Pascaline was invented by Blaise 
Pascal in 1642. Blaise Pascal 
invented this device at the age 
of 18 to assist his father in tax 
calculation. It was the world’s first 
mechanical calculator and was also 
known as Pascal’s calculator or the 
Arithmetic Machine. It was made 
up of a rectangular box with eight 
movable wheels. It could perform 
addition, subtraction, multiplication 
and division by rotating movable 
wheels.
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Stepped Reckoner

A German mathematician Gottfried Wilhelm Lebinitz invented a machine 
called “Stepped Reckoner” in 1642. The Step Reckoner expanded on 
the French mathematician-philosopher Blaise Pascal’s ideas and did 
multiplication by repeated addition and shifting. It was the first calculator 
that could perform all four arithmetic operations: i.e addition, subtraction, 
multiplication and division.

Babbage’s Engines

Charles Babbage was a professor of 
Mathematics at Cambridge University 
in England. He designed an automatic 
mechanical calculating machine, called a 
Difference Engine in 1822 AD. Charles 
Babbage, later designed another machine 
called Analytical Engine in 1833-34. These 
machines could not be built because of 
lack of money and inadequate engineering 
skills at that time. However, he provided 
the basic idea of computers and hence 
he is regarded as “the father of  modern 
computers”.

Facts Corner

Gottfried Wilhelm Leibniz (also known as von 
Leibniz) was a prominent German mathematician, 
philosopher, physicist and statesman.
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Tabulating Machine

Herman Hollerith of United States of America invented Tabulating Machine 
in 1887. This machine used punched card to store data and arrange the data 
in a tabular form. Hollerith’s tabulator was used for the 1890 U. S. census 
(process of counting people). He formed his own company called Tabulating 
Machine company in 1896. This company later joined with other companies 
to form the giant International Business Machines (IBM) Corporation. IBM 
is the biggest computer company in the world now.

Facts Corner The first commercial data processing machines were punched card tabulating systems.

Brainstorming  
task

Fill in the blanks. Choose the answer from the clue box.
Clue  Box

Blaise Pascal,   John Napier,   Gottfried Wilhelm Lebinitz ,  William Oughtred.

a.	 A Napier bone was invented by…………..
b.	 A Slide Rule was invented by…………
c.	 Pascaline was invented by…………
d.	 “Stepped Reckoner” was invented by…………
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Mark-I

The Mark I computer, built at 
Harvard University in 1944, is one 
of the early landmarks of computer 
technology. The computer was 
the brainchild of Howard Aiken, 
a Harvard graduate student and 
then instructor, and was based on 
mechanical, punch-card tabulating 
equipment developed by the 
International Business Machines 
Corporation (IBM). 

expanding 
your horizons

Colossus Machines
The Colossus machines were electronic computing devices used by British 
codebreakers to help read encrypted German messages during World War 
II. These were the world’s first programmable, digital, electronic, computing 
devices. They used vacuum tubes (thermionic valves) to perform the calculations.

This machine used instruction stored in paper tapes and punched cards. It was 
also known as the IBM automatic sequence controlled calculator (ASCC).  
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Attanasoft Berry Computer

ABC is the short for Attanasoft Berry Computer. It was the first electronic 
digital computer invented by Dr.John Attanasoft along with his assistant 
Clifford Berry in 1937-38. This machine laid the foundation for the 
development of electronic digital computer. 

ENIAC and UNIVAC-I

ENIAC (Electronic Numerical Integrator And Calculator) was the first 
electronic digital computer developed by John Eckert and John Mauchly 
in 1946. It was decimal-based, used approximately 18,000 vacuum tubes, 
occupied 1,800 square feet area and performed 5,000 additions/second. It 
was 10 feet tall and weighed approximately 30 tons. 
In 1951, the other successful computer milestone called UNIVAC-I 
(Universal Automatic Computer) was achieved by J. Presper Eckert and 
John Mauchly. It can handle both numeric and textual information. It was 
the first general-purpose electronic digital computer. 
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IBM Model 5150

A personal computer is a general purpose computer based on a single tiny 
silicon chip called a microprocessor that contains all the essential elements 
of a computer. It is designed to meet the personal computing needs of an 
individual, either in working place or at homes. The IBM Personal Computer, 
commonly known as the IBM PC, is the original version and progenitor of 
the IBM PC compatible hardware platform. It is IBM model 5150, and was 
introduced on August 12, 1981. It was created by a team of engineers and 
designers under the direction of Don Estridge of the IBM Entry Systems 
Division in Boca Raton, Florida. 

Facts Corner

In 1981 International Business Machines (IBM), one 
of the world’s largest companies, dominated the 
computer industry.

Brainstorming 

  task

Answer the following questions in short.
a.	 What is Napier bones?
b.	 What is Mark I Computer?
c.	 Who developed ENIAC? When was it invented?
d.	 What is a personal computer?
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Abacus	 :	 The first calculating device invented by 
Chinese.

Napier Bones	 :	 A set of rectangular rods marked with 
numbers on them.

Slide Rule	 :	 A  device consisting of two 
logarithmically scaled rules mounted to 
slide along each other for calculation.

Punched card	 :	 Secondary storage medium consisting 
of  paper or cardboard cards; data is 
recorded by punching holes in the cards.

Tricky Terms 

Let 
Us Revise

•	 Abacus consists of a wooden frame having parallel wires with beads 
strung on them. 

•	 Napier bones are a set of rectangular rods marked with numbers on 
them.

•	 William Oughtred, an English Mathematician invented Slide Rule in 
1620 AD.  

•	 Pascaline was invented by Blaise Pascal in 1642.
•	 A German mathematician Gottfried Wilhelm Lebinitz invented a 

machine called “Stepped Reckoner” in 1642.
•	 Charles Babbage was a professor of Mathematics at Cambridge 

University in England.
•	 Herman Hollerith of United States of America invented Tabulating 

Machine in 1887. 
•	 The Mark I computer, built at Harvard University in 1944, is one of the 

early landmarks of computer technology. 
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
ABC, Slide Rule, Napier’s Bones, Abacus

a.	  ___________________consists of a wooden frame having parallel wires 
with beads strung on them.

b.	 ___________are a set of rectangular rods marked with numbers on them. 
c.	 William Oughtred, an English Mathematician invented 

_________________in 1620 AD. 
d.	 Pascaline was invented by Blaise Pascal in_________________.
e.	 __________________was the first electronic digital computer invented 

by Dr.John Attanasoft along with his assistant Clifford Berry in 1937-38.

2.	 Match the followings.
	 Napier’s Bones			  Herman Hollerith
	 Slide Rule			   Sir John Napier
	 Pascaline			   Charles Babbage
	 Analytical Engine		  William Oughtred
	 Tabulating Machine		  Blaise Pascal

3.	 Say whether these sentences are True or False.
a.	 The early men lived nomadic and unorganized life and they felt no need 

of keeping records.
b.	 Napier bones was first invented by Chinese in sixteenth century.
c.	 William Oughtred, an English Mathematician invented Slide Rule in 

1620 AD. 
d.	 Charles Babbage is regarded as “the father of  modern computers”.
e.	 ENIAC (Electronic Numerical Integrator And Calculator) was the first 

full electronic digital computer developed by John Eckert and John 
Mauchly in 1946.
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4.	 Answer the following questions.
a.	 What is the first tool man had used for calculation?
b.  	What is ABACUS?What are the two sections in an abacus?
c.  	Who invented the first analog computer?
d.  	Why is Charles Babbage called the father of modern computers?
f.  	 Name the two important machines of Charles Babbage. 
i.  	 What is a Tabulating machine? Name the inventor and date of invention. 
g.  	What is Mark-I? Who invented Mark-I?
h.  	Who developed the first electronic digital computer? 

5. 	 Write the full form of the following.
	 ABC		  IBM		  ENIAC		  UNIVAC	       ASCC

Extrapolative Exercise
Fill in the blank spaces with the help of clues.
a.	 The first calculating device invented by Chinese in sixteenth 

century.

b.	 Blaise Pascal invented this device at the age of 18 to assist his 
father in tax calculations. 
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a.		 Define generations of computers.
b.	 Explain the features of different generations of computers.
c.	 Identify the main components used in each generations of computers.
d.	 Identify the inventors of different electronic devices used in different generations of a computer.

Chapter3
Generations of 

Computers

Learning Objectives

An  Overview
The idea of “generations” was created to make it easier to keep a 
perspective on the fast changing computer world. Generation refers to the 
state of improvement in product development process. Similarly, we can 
say generation of computer refers to the state of improvement in computer 
technology. They are classified in terms of speed, storage, size, reliability 
and the components used for manufacturing the machine. The computers in 
past were not just like computers what today they are. The earlier computers 
have very less features. Day by day, the technology is developing and new 
features are being added and the computer is becoming smaller and faster. 
A brief discussion of the various generation of the computer is given below:



24 Computer Zone - Book 5

First Generation Electronic Computers (1937-1953)

The first generation computers were developed between 1937 to 1953.  The 
features of first generation electronic computers are: 
a.	 First generation computers used vacuum tubes.
b.	 Language used in first-generation computers was the machine language.
c.	 They were very large in size and produced a large amount of heat and 

they had to be cooled down by air conditioners.
d.	 The operating system was very slow. They were not reliable.
e.	 They were mainly used in commercial and scientific applications.

Facts Corner

A vacuum tube (also called an electron tube or, in the UK, a valve) is a device 
sometimes used to amplify electronic signals. Vacuum tube was developed by 
Lee DeForest in 1908.

The examples of the first generation computers were ENIAC, EDVAC,  
EDSAC, UNIVAC-I, and IBM 650.  

expanding 
your horizons

IBM 650
The IBM 650 occupies a unique place in computer history as the earliest 
ancestor of the personal computer. It was one of IBM’s early computers, and the 
world’s first mass-produced computer. It was announced in 1953 and almost 
2000 systems were produced in 1962.
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Second Generation Electronic Computers (1954-1962)

The second generation computers were developed between 1954 to 1962.  
The features of second generation electronic computers are: 
a.	 Second generation computers used transistors.  
b.	 They were less expensive, smaller in size than the first generation 

computers.  
c	 They require less electricity and emitted less heat than vacuum tubes.  
d.	 They were more reliable and accurate than that of first generation 

computers.  
e.	 The operating system was comparatively high. 
	 The examples of the second generations were IBM 1620, IBM 1401, 

Control Data 3600, 400 series and IBM 7000 series.  

Facts Corner

The invention of the transistor by three scientists of Bell Telephone Laboratories in 1947 greatly changed the 
computer’s development.  The three Bell Lab scientists’ are John Bardeen, Walter Brattain, and William Shockley. 
Transistors were made of a semiconducting material and controlled the flow of electricity through the circuits.  They 
also allowed computers to become smaller and more powerful and faster at the same time.  
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Third Generation Electronic Computers (1963-1971)

The third generation computers were developed during 1963-1971. The 
features of third generation electronic computers are: 
a.	 Third generation computers used Integrated Circuits in their electronic 

ciruitry.  
b.	 Monitors and keyboards were introduced for input and output of data.  
c.	 Magnetic disks were used for auxiliary memory.  
d.	 The size of the computer became much smaller.  
e.	 The speed of operation was measured in nanoseconds.  
f.	 They had a larger storage capacity. 
	 The examples of third generation computers were IBM system/360, 

Honeywell 200 series, National Cash Register Century Series, ICL 
1900 series and  IBM 370 series. 

Facts Corner

An integrated circuit (IC) is a small electronic device made out of a semiconductor material. The first integrated 
circuit was developed in the 1950s by Jack Kilby of Texas Instruments and Robert Noyce of Fairchild Semiconductor. 
Integrated circuits are used for a variety of devices, including microprocessors, audio and video equipment, and 
automobiles.
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Fourth Generation Electronic Computers (1972-1984)

The fourth generation computers were developed during 1972-1984 The 
features of fourth generation electronic computers are: 
a.	 The fourth generation of computers is marked by the use of Very Large 

Scale Integrated (VLSI) circuits. 
b.	 The computers are highly reliable and accurate.  
c.	 The operating speed is excellent, measured in picoseconds.  
d.	 Micro computers are also introduced.  
e.	 Magnetic disk is the common source of external storage.  
f.	 Application software for microcomputers has become popular.  
	 The examples of this generation are Alto, Apple I, Vax 11/78, IBM PC, 

LISA and Macintosh.

The original Apple Computer, also known as the Apple I, 
or Apple-1, is a personal computer released by the Apple 
Computer Company (now Apple Inc.) in 1976. They were 
designed and hand-built by Steve Wozniak.

The IBM Personal Computer, commonly known as the IBM PC, 
is the original version and progenitor of the IBM PC compatible 
hardware platform. It is IBM model number 5150, and was 
introduced on August 12, 1981. It was created by a team of 
engineers and designers under the direction of Don Estridge of 
the IBM Entry Systems Division in Boca Raton, Florida.
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Fifth Generation Electronic Computers (1983-1990)

The fourth generation computers were developed during 1983-1990. The 
features of fifth generation electronic computers are: 
a.	 These computers have a high speed.  
b.	 These computers use Ultra Large Scale Integration (ULSI).  
c.	 These computers use have Artificial Intelligence. It will contain 

computers that can learn, logic and reason.  
d.	 They process non-numerical informations such as pictures and graphs. 
	 The examples of this generation are IBM PC-AT, PS/2, Intel 80486 and 

Video Toaster.

The NewTek Video Toaster was a combination of hardware and 
software for the editing and production of standard-definition 
video.

expanding 
your horizons

The sixth generation computers refers to the computer and video games, video 
game consoles and video game Handhelds. Platforms of the sixth generation of 
computers include the SEGA Dreamcast, Sony Playstation2 (PS2), NINTENDO, 
Game cube and Microsoft Xbox. This era games began on November 27, 1998 
with the release of the Dreamcast and it was joined by the Playstation2 in 
March, 2000. The Playstation2 is still in production and selling steadily till 
date (which is still one of the sixth generation computers). 
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Artificial Intelligence	 :  	 An area of computer science 
that emphasizes the creation of 
intelligent machines that work 
and react like humans.  

Chip	 :  	 A small slice of silicon material 
on which integrated electronic 
components are deposited.  

Circuits	 :  	 The complete path of an electric 
current including  the source of 
electricity and the conductors  
through which it flows.

Tricky Terms 

Let 
Us Revise

•	 Generation refers to the state of improvement in product development 
process. 

•	 The first generation computers were developed between 1937 to 1953.
•	 The examples of the first generation computers were ENIAC, EDVAC,  

EDSAC, UNIVAC-I, and IBM 650.
•	 The second generation computers were developed between 1954 to 

1962.
•	 Second generation computers used transistors.   
•	 The examples of the second generations were IBM 1620, IBM 1401, 

Control Data 3600, 400 series and IBM 7000 series. 
•	 Third generation computers used Integrated Circuits in their electronic 

ciruitry.   
•	 The fourth generation of computers is marked by the use of Very Large 

Scale Integrated (VLSI) circuits. 
•	 The fifth generation computers will have Artificial Intelligence.
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
IC,  Fourth,  Generation,  Second,  Vaccum tube

a.	 _______________refers to the state of improvement in product 
development process. 

b.	 First generation computers used____________________.
c.	 The examples of the __________________generations were IBM 1620, 

IBM 1401, Control Data 3600, 400 series and IBM 7000 series. 
d.	 An ________________ is a small electronic device made out of a 

semiconductor material. 
e.	 The __________________ generation of computers is marked by the use 

of Very Large Scale Integrated (VLSI) circuits. 

2.	 Match the followings.
	 First generation computer			   Integrated Circuits
	 Second generation computer		  VLSI
	 Third generation computer			   vacuum tubes 
	 Fourth generation computer			  Artificial Intelligence
	 Fifth generation computer			   transistors 

3.	 Say whether these sentences are True or False.
a.	 Language used in first-generation computers was the machine language.
b.	 Second generation computers used vacuum tubes. 
c.	 Third generation computers used Integrated Circuits in their electronic 

ciruitry. 
d.	 The examples of third generation are Alto, Apple I, Vax 11/78, IBM PC, 

LISA and Macintosh.
e.	 The sixth generation computers refers to the computer and video games, 

video game consoles and video game Handhelds.



31Computer Zone - Book 5

4.	 Answer the following questions.
a.	 What is meant by generation of computers? How many generation of 

computers are there? 
b. 	 What are the features of the first generation computers? 
c.  	How were the second generation computers an improvement over their 

predecessors? 
d. 	 What is used in the electronic ciruitry of the third generation computers? 
e.  	Mention any three features of fourth generation computers? 
f.  	 What do you understand by the term “Artificial Intelligence”? 
l.  	 What are the special features of fifth generation that makes it different 

from the other generations?

5.	 Write the full form of the following.
	    AI   IC		 VLSI		  ULSI          ENIAC

Extrapolative Exercise
Identify and name the following electronic devices and name 
their inventors.
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a.	 Define the Internet and explain the history of  the  Internet.
b.	 State the uses of  the Internet.
c.	 Identify the different items required for connecting to the Internet.
d.	 Explain how to search the Web using  a search engine.
e.	 Explain E-Mail service on the Net.

Chapter4
Presenting

the Internet
Learning Objectives

An  Overview
Internet stands for Interconnected Network. The Internet is the world’s 
largest computer network. A computer network is a group of computers 
connected to each other electronically. Internet is the largest network of 
interconnected computers world-wide. It is capable of communicating 
and sharing data with each other. It is a network of networks or it can be 
called the mother of all networks. Today, the Internet connects thousands 
of networks and more than million of users around the world. It is a huge 
network with no central administration. All the computers are located at 
different places and are connected to each other through telephone lines 
and satellite links. 
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History of Internet

The Internet was started in the Pentagon, the US Department of Defense. 
A networking project called ARPA or Advanced Research Projects Agency. 
was launched, which has to work as a network that would allow scientists 
and military personnel to exchange information in a war scenario without 
disruption in communications. This network, called ARPANET, became 
functional in September 1969, linking scientific and academic researchers 
in the United States.
Researchers and academics in other fields began to make use of the 
network. In 1986, National Science Foundation (NSF) connected its huge 
network of five supercomputer centers, called NSFnet. to ARPANET. This 
configuration of complex networks became Internet.

Facts Corner

The Internet is a huge network of networks that links computers together all over the world using a range of wires 
and wireless technologies. The World Wide Web is the collection of linked pages that are accessed using the Internet 
and a web browser.
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Uses of the Internet

Internet is one of the most important part of our daily life. There are 
large numbers of things that can be done using the Internet and so it is 
very important. You can say that with the progress in the Internet, we are 
progressing in every sphere of life as it not only makes our tasks easier 
but also saves a lot of time. Today Internet is used for different purposes 
depending upon the requirement. Some of the uses of the Internet are:
a.	 The Internet provides a rich and wide source of information and an 

essential communicating tool. 
b.	 It also provides many services such as online banking, applications, 

shopping and job seeking.
c.	 It allows people on one computer to connect to a remote computer.
d.	 It provides ther cheapest and fastest means to access and provide 

information.
e.	 It allows you to complete your business transactions in the market place. 

Brainstorming 

  task
Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Internet, Pentagon, Network, ARPANET, Interconnected Network

a.	 Internet stands for________________________.
b.	 A ___________________ is a group of computers connected to each 

other electronically. 
c.	 The Internet was started in the__________________________.
d.	 This network, called_______________, became functional in September 

1969, linking scientific and academic researchers in the United States.
e.	 The__________________provides a rich and wide source of 

information and an essential communicating tool.  
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Requirements for connecting to the Internet

For an Internet connection, you require following items:
Multimedia Computer System
A computer preferably with a fast processor and lots of memory (1 Gb or 
more).

MODEM
MODEM stands for MODULATOR-DEMODULATOR. It is a device that 
converts a computer’s outgoing data into a format that can be transferred 
via communication lines.

Telephone/Cable/Wireless Connection
A communication line is required to transfer the data from one computer to 
another computer. It can be a telephone line or a cable or wireless connection.

Subscription with an Internet Service Provider (ISP)
Internet Service Providers (ISPs) are companies that provide access to the 
Internet. Your computer must have an Internet Connection that is provided 
by different Internet Service Providers (ISP) at monthly charges. 

Web Browser
Web browser is a software used to access and navigate webpages on the 
Internet. It lets us view the contents of a webpage. Some popular Internet 
web browsers are:
a. 	 Mozilla Firefox
b. 	 Netscape Navigator
c. 	 Microsoft Internet Explorer
d. 	 Safari Apple
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Internet Terminology

World Wide Web
The World Wide Web, abbreviated as WWW, commonly known as Web 
is the largest collection of information on Internet. It contains millions of 
Web sites, which provides information in the form of text, graphic, sounds 
and digital movies. WWW is a storehouse of information that resides on 
computer called Web server.

Web Site
A website is a collection of Web pages, images, videos or other digital 
assets that is hosted on one or several Web server(s), usually accessible via 
the Internet. The different Web sites are created and maintained by different 
colleges, universities, government agencies, companies and organizations.
All websites enabled through the Internet constitute the World Wide Web 
(WWW). 

Web Page
A digital file or document or a particular Web site is known as a Web page. 
It is a document that includes text, images, sound and video. A web site can 
consists of one or more Web pages.  

Facts Corner

A web page (or webpage) is a web document that is suitable for the World Wide Web and the web browser.
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Web Server
A web server is a computer that stores websites on the Internet and delivers 
web pages to viewers upon request. This service is referred to as web hosting. 
Web server is usually a very fast, powerful and with large storage capacity of 
computer that can handle thousands of visitors at a time. 

Web Browser
Web browser is software that is used to access the internet. A browser lets you 
visit websites and do activities within them like login, view multimedia, link 
from one site to another, visit one page from another, print, send and receive 
email, among many other activities. The most common browser software 
titles on the market are: Microsoft Internet Explorer,Google’s Chrome, 
Mozilla Firefox, Apple Computer’s Safari, and Opera.

Home Page
Home page is the initial page of a website, the ‘point of entry’ to all the 
information stored within. It’s similar to the front page of a newspaper, but a 
home page contains links to a selection (or, in some cases, all) of the available 
content. The term ‘home page’ is also used to refer to the page you encounter 
first when connecting to the internet. 
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Searching the Web

The World Wide Web contains millions of pages of information. It is not 
easy always easy to find what you want on the Web. In such cases, you 
can take the help of search engines. A search engine is a web-based tool 
that enables users to locate information on the World Wide Web. Popular 
examples of search engines are Google, Yahoo!, and MSN Search. Search 
engines utilize automated software applications (referred to as robots, bots, 
or spiders) that travel along the Web, following links from page to page, site 
to site. The information gathered by the spiders is used to create a searchable 
index of the Web.

Using a Search Engine
You do not always have to know a website’s address in order to use the 
Internet. It is important to know how to search for information. One of 
the best methods to search is to use a search engine. A search engine is 
a software system on the Internet that will conduct a search of its own 
database of websites based on terms you have entered. As a result, you will 
be shown a list of web addresses that contain the term you were looking to 
find. An example of a popular search engine is www.google.com. 
a.	 Launch your Web browser. 
b.	 To conduct the search, point and click your mouse in the search textbox. 

Type in the textbox the words or words you would like to search. Then 
point and click your mouse on the Google Search button below the 
search textbox.

Every phrase in either blue with an underline may be clicked on to visit that 
particular site. These are hyperlinks to websites. The websites deemed most 
fitting for the search are found at the near the top of the list. There are also 
paid sponsors found at the top (shaded) and to the right of the screen that 
you may visit if you wish. You can see actual web addresses in green text. 
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E-Mail Service on the Net

The simplest and the most widely used service available on the Internet is 
the electronic mail service which is commonly called, in short, as the e-mail 
service. Email, e-mail or electronic mail is the transmission of messages 
(emails or email messages) over electronic networks like the Internet. This 
communication method is so fast that passes messages to their destination 
within minutes.

Using GMAIL
Gmail is a popular, web-based email service provided by Google. Gmail 
has a wide range of features, ranging from standard features that all email 
services have (such as the ability to send and receive emails), to some more 
unique features such as Priority Inbox, Conversation View, and the ability 
to call any phone in the world.
To use Gmail, follow these steps:
a.	 Open Gmail and type your login name.
b.	 Press TAB and enter your password. When the screen with your name 

opens, you are ready to send and receive email.

c.	 Click Compose to open a blank message.
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Email Etiquette Tips

It is important that whether for business or personal use that you follow the 
basics of email etiquette. Some of the Email etiquette tips are as follows:
a.	 Make sure your e-mail includes a courteous greeting and closing.
b.	 Be sure the Subject: field accurately reflects the content of your email.
c.	 Always end your emails with “Thank you,” “Sincerely,” and  “Best 

regards”.
d.	 Never send large attachments without notice. Always ask what would be 

the best time to send them first.

e.	 Do not type in all caps. That’s yelling or reflects shouting emphasis.

d.	 Type the email address of the receiver. Then, fill in the Cc, Bcc boxes if 
you want to.

e.	 Type the subject.
f.	 Type the message.
g.	 Click the Send button.

Brainstorming 

  task

Give one word answer for each of the following:
a.	 A device that converts a computer’s outgoing data into a format that 

can be transferred via communication lines.
b.	 A software used to access and navigate webpages on the Internet. 
c.	 A digital file or document or a particular Web site is known as a Web 

page.
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Internet	 :  	 The largest network of 
interconnected computers world-
wide.

Website	 :	 A collection of Web pages, 
images, videos or other digital 
assets that is hosted on one or 
several Web server(s), usually 
accessible via the Internet. 

Web page	 :	 A digital file or document or a 
particular Web site.

Home page	 :	 The initial page of a website, 
the ‘point of entry’ to all the 
information stored within.

Tricky Terms 

Let 
Us Revise

•	 A computer network is a group of computers connected to each other 
electronically.

•	 The Internet was started in the Pentagon, the US Department of Defense.
•	 A networking project called ARPA or Advanced Research Projects 

Agency. 
•	 The Internet provides a rich and wide source of information and an 

essential communicating tool. 
•	 The World Wide Web, abbreviated as WWW, commonly known as Web 

is the largest collection of information on Internet. 
•	 A website is a collection of Web pages, images, videos or other digital 

assets that is hosted on one or several Web server(s), usually accessible 
via the Internet. 

•	 A digital file or document or a particular Web site is known as a Web 
page. 
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Gmail, Home page, web page,  Mozilla Firefox,  World Wide Web

a.	 _____________________ is the collection of linked pages that are 
accessed using the internet and a web browser.

b.	 _____________________ is the example of a web browser.
c.	 A digital file or document or a particular web site is known as a 

____________________ .
d.	 _____________________ is the initial page of a web site.
e.	 ____________ is a popular web based email service provided by Google.

2.	 Match the followings.
	 Web client	 A collection of Web pages, images, videos or other 

digital assets that is hosted on one or several Web 
server(s), usually accessible via the Internet. 

	 Website 	 A computer that stores websites on the Internet and 
delivers web pages to viewers upon request. 

	 Home page 	 The software that is used to access the internet. 
	 Web chat 	 The initial page of a website, the ‘point of entry’ to 

all the information stored within.
	 Web browser 	 The transmission of messages (emails or email 

messages) over electronic networks like the 
Internet. 

3.	 Say whether these sentences are True or False.
a.	 The Internet provides a rich and wide source of information and an 

essential communicating tool.
b.	 Internet Service Providers (ISPs) are companies that provide access to 

the Internet.
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c.	 A digital file or document or a particular Web site is known as a Web 
server.

d.	 A web page is the initial page of a website, the ‘point of entry’ to all the 
information stored within.

e.	 A search engine is a web-based tool that enables users to locate information 
on the World Wide Web. 

4.	 Answer the following questions.
a.	 What do you understand by Internet?
b.	 Explain in short the history of Internet.
c.	 State any three uses of the Internet.  
d.	 What are the requirements for getting connected to the Internet?
e.	 Define the following terms:
	 i. World Wide Web		  ii. Web page		 iii. Home page 
f.	 What are search engines? Name two popular search engines.
g.		 List any three important rules that should be followed while sending an 

email.
  
5. 	 Write the full form of the following.
	 NSF		  MODEM		  ISP		  WWW            E-Mail

Lesson Labs

a.	 Connect to the Internet.
b.	 Open the Internet explorer or Netscape Navigator.
	 Visit the following web sites:
	 www.yahoo.com
	 www.google.com
c.	 Use the Internet to find information on “Nepal” Past”.
d.	 Create an E-Mail account in Gmail. Using that account send an E-Mail message to your friend describing 

your school and what you have learnt about computers till now.
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a.	 Explain  in short Microsoft Windows 7.
b.	 Identify the steps to open the Accessories Menu.
c.	 Explain the main programs found in Windows Accessories.
d.	 Explain how to use Calculator program.
e.	 Explain how to  draw shapes in  Paint program.
f.	 Explain how to use word processing accessories in Windows 7.

Chapter5
Microsoft

Windows Accessories
Learning Objectives

An  Overview
Windows 7 is a Graphical User Interface (GUI) based operating system. 
It is the Microsoft Windows operating system released commercially in 
October 2009. In development, Windows 7 was known by the code names 
“Blackcomb” and “Vienna.” It is a very special software, which starts up 
your computer and helps you to use other programs on the computer to 
carry out a variety of tasks. It has a variety of accessories listed on the start 
menu. The OS is widely available in three retail editions: Windows 7 Home 
Premium, Professional and Ultimate. Starter, OEM and Enterprise editions 
are available in some markets. These accessories provide plenty of good 
additional extras alongside the Windows system tools.
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Opening the Accessories Menu

Windows Accessories is a special package of software. Windows has 
many accessories for day to day use and tools for maintaining computer in 
good shape. Some of the main Windows Accessories are Calculator, Paint, 
Notepad, WordPad and Windows Explorer.
To open Accessories menu, follow these steps:
a.	 Click on Start button.
b.	 Click on All Programs.
c.	 Now, click on Accessories. Accessories menu appears.
d.	 Choose the program to open by clicking on its name in the menu.

Calculator
The calculator is one of the handiest Windows 7 Accessories. The Windows 
7 calculator has been enhanced with additional programmer and statistics 
options along with the scientific and standard calculator models. The 
calculator also has some quick tools for mortgage calculations, fuel economy, 
and vehicle leasing.
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To open calculator, follow these steps:
a.	 Click on Start button.
b.	 Click on All Programs.
c.	 Click on Accessories.
d.	 Click Calculator.

The calculator application opens in default view, which is the standard view.

Number box

Operation Keys

Number Keys

The calculator application is small and has a simple interface. The title bar has 
the name of the application. It also has Minimize and Close buttons. Various 
buttons found on it are numeric buttons, operators and memory buttons.
a.	 There are ten numeric buttons from 0 to 9. You can use these to enter 

numbers.
b.	 Operator buttons have symbols that represent mathematical operators. 

These are located on the right. There is also a button with an equal “=” 
sign.

c.	 The C button is used to clear the last calculation. 
d.	 The CE button is used to erase the last display.
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Paint
PAINT is a simple graphic program that you can use to create drawings on 
a blank canvas or on top of other pictures. It is located in Accessories. This 
is done by using the various tools and colours present in the Paint program.
To open Paint, follow these steps: 
a.	 Click on the Start button.
b.	 Click on All Programs.
c.	 Select Accessories. You will notice a list of options.	
d.	 Click on Paint. The Paint window appears on the screen.

Paint lets you draw many different shapes. For example, you can draw 
ready-made, defined shapes such as rectangles, circles, squares, triangles, 
and arrows.
To draw shapes, do the followings:	
a.	 On the Home tab, in the Shapes group, click a ready-made shape, such as 

the Rectangle‌.
b.	 To add a ready-made shape, drag the pointer across the drawing area to 

make the shape.
c.	 To change the outline style, in the Shapes group, click Outline, and then 

click an outline style. 
	 If you don’t want your shape to have an outline, click No outline.
d.	 In the Colors group, click Color 1, and then click a color for the outline.
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e.	 In the Colors group, click Color 2, and then click a color to use to fill the 
shape.

f.	 To change the fill style, in the Shapes group, click Fill, and then click a 
fill style.

	 If you don’t want your shape to be filled, click No fill.

Notepad
Notepad is a text editor that is used to edit simple text documents that do not 
require any special formatting effects.
To open Notepad, follow these steps: 
a.	 Click on the Start button.
b.	 Click on All Programs.
c.	 Select Accessories. You will notice a list of options.	
d.	 Click on Notepad. The Notepad window appears on the screen.

Menu bar
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WordPad
WordPad is a word processing program present in Windows Accessories. 
It allows you to create simple letters and documents. It also provides many 
formatting features to give an attractive look to your documents.
To open WordPad, follow these steps: 
a.	 Click on the Start button.
b.	 Click on All Programs.
c.	 Select Accessories. You will notice a list of options.	
d.	 Click on WordPad. 
The WordPad window appears on the screen. 

 he computer’s disk or any other secondary storage media. It is divided 
vertically into two sections. The left side displays the disk drives and folders 
in the form of a folder tree and the right side displays folders and files you 
have chosen from the left pane.

To enter text in WordPad, do the followings:	
a.	 Type a paragraph.
b.	 Press Enter key only when you want to start a new line or paragraph.
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Windows 7	 :  	 A Graphical User Interface (GUI) 
based operating system. 

GUI	 :	 A program interface that takes 
advantage of the computer’s 
graphics capabilities to make the 
program easier to use.

PAINT	 :	 A simple graphic program that 
you can use to create drawings on 
a blank canvas or on top of other 
pictures. 

Notepad	 :	 A text editor that is used to edit 
simple text documents that do not 
require any special formatting 
effects.

Tricky Terms 

Let 
Us Revise

•	 Windows 7 is a Graphical User Interface (GUI) based operating system. 
•	 The Windows 7 calculator has been enhanced with additional programmer 

and statistics options along with the scientific and standard calculator 
models.	

•	 PAINT is a simple graphic program that you can use to create drawings 
on a blank canvas or on top of other pictures.

•	 Notepad is a text editor that is used to edit simple text documents that 
do not require any special formatting effects.	

•	 WordPad is a word processing program present in Windows 
Accessories.	

•	 The Windows Explorer is a program which allows you to efficiently 
manage files and folders present in the computer’s disk or any other 
secondary storage media.	
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Word pad, Paint, software, Notepad,  GUI

a.	 Windows 7 is a _____________________ based operating system.
b.	 _____________________ is a simple graphics program.
c.	 _____________________ is a word p  rocessing program present in 

windows Accessories.
d.	 _________________ is a text editor that is used to edit simple text 

documents.
e.	 Windows Accessories is a special package of ____________________ .

2.	 Match the followings.
	 PAINT		 A Graphical User Interface (GUI) based operating 

system. 
	 Windows 7	 A program interface that takes advantage of the 

computer’s graphics capabilities to make the 
program easier to use.

	 Notepad		 A simple graphic program that you can use to 
create drawings on a blank canvas or on top of 
other pictures. 

	 Windows Explorer	 A text editor that is used to edit simple text 
documents that do not require any special 
formatting effects.

	 GUI 	 A program which allows you to efficiently manage 
files and folders present in the computer’s disk or 
any other secondary storage media. 
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3.	 Answer the following questions.
a.	 What is Windows 7? Is Windows 7 a Graphical User Interface?
b.	 What is Windows Accessories? Name some of the main Windows 

Accessories.
c.	 Write the steps to open the Accessories menu.
d.	 How do you use the Windows Calculator?
e.	 What is a Paint program? Write the steps to draw shapes in Paint program.
f.	 What is Windows Explorer?

Lesson Labs

a.	 Open the calculator and work out (45 x 22) - (31 x 15)
	 i. 	 Press 31 x 15 and press equal button to display the result.
	 ii. 	 Press MS to store the result in memory.
	 iii. 	 Press 45 x 22 and press the equal button to display the result.
	 iv. 	 Press the minus button.
	 v. 	 Press MC to recall the number stored in memory.
	 vi. 	 Press the equal button to display the result.

b.	 Type the following text in any word processor and do the tasks given below. 
	 One fine evening a young princess put on her bonnet and clogs, and went out to take a walk by herself in 

a wood; and when she came to a cool spring of water with a rose in the middle of it, she sat herself down 
to rest a while. Now she had a golden ball in her hand, which was her favourite plaything; and she was 
always tossing it up into the air, and catching it again as it fell. 

	 i.	 Format the heading “Princess” to 16 point bold and place it at the centre.
	 ii.  	 Format the entire document to Arial black.  
	 iii.  	 Format the important words of your text to italics.
	 iv.  	 Change the alignment as centred.
	 v.  	 Save the document as “Princess” and close the document.
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a.	 Define word processing software and explain the advantages of Microsoft Office Word 2010.
b.	 Define Backstage view and identify the different options of backstage view.
c.	 Explain the steps to format text in  Microsoft Office Word 2010.
d.	 Define paragraph alignment and explain the steps to change the paragraph alignment.
e.	 Define text boxes and explain the steps to insert text boxes in Word document.
f.	 Explain how to save a document  in Microsoft Office Word 2010.

Chapter6
Formatting in 

Word 2010
Learning Objectives

An  Overview
Word processing software is the most popular type of computer software. It 
is an application software that provides extensive tools to create, view, edit, 
format, store and print text materials for human communication. It can also 
be referred as “text editor”. It processes words. It also processes paragraphs, 
pages, and entire papers. It has replaced the electronic typewriter in most of 
the places, as document can be easily edited, searched and reprinted in it. 
There are many word processing software packages available for use with 
personal computers. Some examples of word processing software include 
Microsoft Word, WordPerfect (Windows only), AppleWorks (Mac only), 
and OpenOffice.org.
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Microsoft Office Word 2010

Microsoft Office Word 2010 is a full-featured word processing program that 
allows you to create professional looking documents. It is one of the products 
under the MS-Office packages developed by Microsoft Corporation, USA. 
Microsoft Office Word has the following advantages:
a.	 Word excels in its ability to change or edit a document.	
b.	 Word provides tools that enable you to create Web pages with ease.
c.	 Word provides you with powerful desktop publishing tools to use as you 

create professional looking brochures, advertisements, and newsletters.
d.	 The drawing tools in Word allows you to design impressive 3-D effects 

by including shadows, textures and curves.	
e.	 Word has many features that controls the appearance or format of the 

document.

Quick Access Toolbar

Ribbon

File Tab

Work Area

Button to change view of 
documents

Facts Corner

The first word processors were basically computerized typewriters, which did little more than place characters on 
a screen, which could then be printed by a printer.
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Introducing Backstage

The Backstage view has been introduced in Word 2010 and acts as the 
central place for managing your documents. The backstage view helps 
in creating new documents, saving and opening documents, printing and 
sharing documents, and so on.

Click on File Tab. A new screen 
will appear, displaying the 
most commonly used file 
management commands.

First column of the backstage view will have following options:
Save 	 If an existing document is opened, it would be saved as is, 

otherwise it will display a dialog box asking for document 
name. 

Save As 	 A dialog box will be displayed asking for document name 
and document type, by default it will save in word 2010 
format with extension .docx 

Open 	 This option will be used to open an existing word document. 
Close 	 This option will be used to close an opened document. 
Info 	 This option will display information about the opened 

document. 
Recent 	 This option will list down all the recently opened documents. 
New 	 This option will be used to open a new document. 
Print 	 This option will be used to print an opened document. 
Save & Send 	 This option will save an opened document and will display 

options to send the document using email etc. 
Help 	 You can use this option to get required help about word 

2010. 
Options 	 This option is used to set various option related to word 

2010. 
Exit 	 This option is used to close the document and exit. 
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Setting Text Fonts and Size 

A font, also commonly referred to as a typeface, is a set of characters with 
a specific design. The designs have names such as Times New Roman and 
Courier. Using fonts as a design element can add interest to your document 
and give readers visual cues to help them find information quickly. 
Each font has one or more sizes. Size is the height and width of the character 
and is commonly measured in points, abbreviated “pt”. One point equals 
about 1/72 inch, and the text in most documents is 10 pt or 12 pt.
To change font and size of the text, do the following:
a.	 Select the text that you want to change to a different font and click Home 

tab. Now click Font Type button to list down all the fonts available as 
shown below.

b.	 Try to move mouse pointer over different fonts listed. You will see that 
text font changes when you move mouse pointer over different fonts. 
You can use Font Scroll Bar to display more fonts available. 

c.	 Similar way, to change the font size, click over the Font Size button 
which will display a font size list. You will use same procedure to select 
a desired font size what you have used while selecting a font type.
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Changing Text Case

You can change the case of the text in your document without retyping the 
text i.e, the text written in small letters can be changed into capital or a vice 
versa. Word offers five case styles to choose from.
Sentence Case	 The text will be in the form of a sentence i.e. the 

first character of sentence will be capital (upper 
case) and rest will be in small (lower case).

Lower Case 	 The text will be changed into small letters by 
using this option.

Upper Case	 The text will be changed into capital letters.
Capitalize each word	 The first character of each word will be 

capitalized of the text.
tOGGLE cASE	 The first character of the word will be small and 

rest in capital.
To change the text case, do the followings:
a.	 Select the text that you want to change to a new style.
b.	 Click on Home tab on the ribbon.
c.	 Click on Change Case button.
d.	 Click on the case style you want to use.
The text you have selected changes to the new case style.
To deselect the text, click on outside the selected area.

Change Case Option
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Paragraph Alignment

Paragraph alignment refers to the manner in which the left and right ends 
of lines of the text are aligned. There are four types of  paragraph alignment 
style. You can choose any one of the styles. These styles are: left alignment, 
right alignment, center alignment and justified.
To change the paragraph alignment, do the followings:	
a.	 Select the text you wish to modify.
b.	 Select one of the four alignment options from the Paragraph group on 

the Home tab.

Line Spacing

Line spacing is the vertical distance between the lines of text. It is set to a 
single line spacing by default in Word 2010. Line spacing is a paragraph 
format setting, therefore, it affects the paragraph containing the insertion 
point or all paragraphs in a selection. 
To change the line spacing, do the following:
a.	 Select the paragraph or paragraphs for which you want to define spacing. 

You can use any of the text selection method to select the paragraph(s).
b.	 Click the Line and Paragraph Spacing Button triangle to display a list 

of options to adjust space between the lines. You can select any of the 
option available by simply clicking over it.
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Paragraph Spacing

The appearance of your documents improves if some blank space is 
left between the end of one paragraph and the start of the next. You can 
accomplish this by pressing Enter twice at the end of a paragraph. By using 
paragraph dialog box, you can have greater control over your paragraph 
spacing and save time, too. Extra spacing between paragraphs helps to 
make a document easier to read.
To format paragraph spacing, do the followings:
a.	 Click the Line and Paragraph Spacing command on the Home tab.
b.	 Select Add Space Before Paragraph or Remove Space After Paragraph 

from the drop-down menu.
c.	 From the drop-down menu, you can also select Line Spacing Options to 

open the Paragraph dialog box. From here, you can control exactly how 
much space there is before and after the paragraph.

You can use Word’s convenient Set as Default feature to save all of the 
formatting changes you’ve made and automatically apply them to new 
documents. 
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Inserting Text Boxes 

Text boxes are the containers for text or graphics. They are useful for 
helping to organize your document. They are basically treated the same as 
shapes, so when you insert a text box, you can and format it by changing its 
fill color, outline color, and shape style, as well as create WordArt and add 
3-D effects.
To insert text boxes, do the followings:
a.	 Select the Insert tab on the Ribbon.
b.	 Click the Text Box command in the Text group. A drop-down menu will 

appear.

c.	 Select Draw Text Box. 
d.		 Click and drag on the document to create the text box. 
e.	 You can now start typing to create text inside the text box. 
	 From the drop-down menu, you can also select one of the built-in text 

boxes that have pre-defined colors, fonts, positions, and sizes. If you 
choose this option, the text box will appear automatically, so you will not 
need to click and drag to draw it.
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Saving a Document

It is important to know how to save the documents you are working with. 
Frequently saving your documents helps to keep you from losing your 
work, and using ‘Save As’ allows you to edit a document while leaving 
the original copy unchanged. There are many ways you share and receive 
documents, which will affect how you need to save the file.
To use the Save As command, do the followings: 
Save As allows you to choose a name and location for your document. It’s 
useful if you’ve first created a document or if you want to save a different 
version of a document while keeping the original.
a.	 Click the File tab.
b.	 Select Save As. 

c.	 The Save As dialog box will appear. Select the location where you wish 
to save the document.

d.	 Enter a name for the document and click Save. 
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Wordprocessing	 :  	 An application software that 
provides extensive tools to create, 
view, edit, format, store and 
print text materials for human 
communication. 

Word 2010	 : 	 A full-featured word processing 
program that allows you to create 
professional looking documents.

Font	 :	 A typeface, is a set of characters 
with a specific design.

Paragraph alignment	 :	 Refers to the manner in which 
the left and right ends of lines 
of the text are aligned.

Tricky Terms 

Let 
Us Revise

•	 Wordprocessing is an application software that provides extensive tools 
to create, view, edit, format, store and print text materials for human 
communication. 

•	 Microsoft Office Word 2010 is a full-featured word processing program 
that allows you to create professional looking documents. 

•	 The backstage view helps in creating new documents, saving and 
opening documents, printing and sharing documents, and so on.

•	 A font, also commonly referred to as a typeface, is a set of characters 
with a specific design. 

•	 Paragraph alignment refers to the manner in which the left and right 
ends of lines of the text are aligned. 	

•	 Line spacing is the vertical distance between the lines of text. 
•	 Text boxes are the containers for text or graphics.
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Text boxes, Line spacing, backstage, typeface, paragraph alignment

a.	 The __________________ view helps in creating new documents, saving 
and opening documents, printing and sharing documents, and so on.

b.	 A_______________________is a set of characters with a specific design.
c.	 ____________________refers to the manner in which the left and 

right ends of lines of the text are aligned. 	
d.	 ____________________is the vertical distance between the lines of text. 
e.	 _________________________are the containers for text or graphics. 

2.	 Match each term with the statement that best describes it.
Word 2010	   	 An application software that provides extensive 

tools to create, view, edit, format, store and print 
text materials for human communication. 

Wordprocessing	  	 A full-featured word processing program that 
allows you to create professional looking 
documents.

Paragraph alignment		 A typeface, is a set of characters with a specific 
design.

Text boxes		  Refers to the manner in which the left and 
right ends of lines of the text are aligned. 

Font 		  The containers for text or graphics.   

3.	 Say whether these sentences are True or False.
a.	 Microsoft Office Word 2010 is a full-featured word processing program 

that allows you to create professional looking documents.
b.	 The drawing tools in Word allows you to design impressive 3-D effects 

by including shadows, textures and curves.
c.	 Recent option will display information about the opened document.
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Lesson Labs

Set A
Open a new file in the Word 2010 and type a short story. Now perform the following formatting options.
The Frog Prince
One fine evening a young princess put on her bonnet and clogs, and went out to take a walk by herself in a 
wood; and when she came to a cool spring of water with a rose in the middle of it, she sat herself down to rest a 
while. Now she had a golden ball in her hand, which was her favourite plaything; and she was always tossing 
it up into the air, and catching it again as it fell. 
a.	 Change the title font to Arial (or a font of your choice), 16 pt.
b.	 Center the title.
c. 	 Add italics and bold to the word “The Frog Prince”.
d. 	 Change the alignment as justified.
e.	 Insert any suitable clip art image on your data disk below the title. Size it appropriately and center it 

below the title.
f.	 Save the document as “The Frog Prince” on your data disk.  

d.	 One point equals about 1/72 inch, and the text in most documents is 10 
pt or 12 pt.

e.	 Line spacing is set to a single line spacing by default in Microsoft Word.

4.	 Answer the following questions.
a.	 What is a word processing software? Name some popular word 

processing software.
b.	 List any five advantages of Microsoft Office Word 2010.
c.	 What is backstage view?
d.	 What is a font? What is the default font in Word 2010?
e.	 What are the five case styles of Text Case?
f.	 What is paragraph alignment?
g.	 What is line spacing? What is the default line spacing in Word 2010?
h.	 What is paragraph spacing? 
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Set B
Start Word and type the following text exactly like given below :
School Ahead
Teacher	 : 	 Why are you late, John? 
John	 : 	 Because of the sign. 
Teacher	 : 	 What sign? 
John	 : 	 The one that says, “School Ahead, Go Slow.
a.	 Correct any spelling or grammar errors.
b.	 Bold and center the title.
c.	 Change the title font to Impact (or a font of your choice), 16 pt.
d.	 Add a colour of your choice to the title text.	
e.	 Format the entire document to the Courier New.  	
f. 	 Insert any suitable clipart at the top of the page.	
g. 	 Change the alignment to justified.	
h. 	 Save the document as “School Ahead”.
i.	 Close the document and exit Microsoft Word.

Set  C
Start Word and type the following text exactly like given below :
Whilst she was speaking, a frog put its head out of the water, and said, ‘Princess, why do you weep so bitterly?’ 
 ‘Alas!’ said she, ‘what can you do for me, you nasty frog? My golden ball has fallen into the spring.’  The frog said, 
‘I do not want your pearls, and jewels, and fine clothes; but if you will love me, and let me live with you and eat 
from off your golden plate, and sleep on your bed, I will bring you your ball again.’ 
a.	 Correct any spelling or grammar errors that are identified.
b.	 Bold and center the first three lines. 
c.	 Change the font to a font of your choice, 16 pt.
d.	 Add colour of your choice to the three lines.
e.	 Change the font size of the remaining paragraphs to 11 pt and change the alignment to justified.
f.	 Insert the clip art image on the right hand side of the text. Size it appropriately and center it.	
g.	 Save the document as “Health” on your data disk.	
h.	 Close the document and exit Microsoft Word. 
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a.	 Define presentation program and explain the advantages of Microsoft Office PowerPoint 2010.
b.	 Explain how to create a blank presentation with design theme.
c.	 Explain how to insert slide in a presentation.
d.	 Explain how to format text in a presentation.
e.	 Identify the steps to animate text and object in Microsoft Office PowerPoint 2010.
f.	 Define transition and identify the steps to apply a transition in Microsoft Office PowerPoint 2010.

Chapter7
Introducing

PowerPoint 2010
Learning Objectives

An  Overview
A presentation program is a computer software package that allows you to 
create documents called presentation. Presentation is a systematic display 
of information along with graphics. It typically includes three major 
functions: an editor that allows text to be inserted and formatted, a method 
for inserting and manipulating graphic images and a slide-show system to 
display the content. 
PowerPoint 2010 is a visual and graphical application, primarily used for 
creating presentations. With PowerPoint, you can create, view, and present 
slide shows that combine text, shapes, pictures, graphs, animation, charts, 
videos, and much more.
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Microsoft Office PowerPoint 2010

Microsoft Office PowerPoint 2010, is a presentation developed by 
Microsoft Corporation, USA. It allows you to produce professional-looking 
presentations and handouts. 
Microsoft Office PowerPoint has the following advantages:
a.		 Save time and money by applying sophisticated photo effects without 

using additional photo-editing software programs
b.		 Allow to create presentations for lectures, research reports and meeting 

handouts 
c.		 Allow to insert pictures from the Clip Gallery into your presentation 
d.		 Allow to insert sound, music, videos and animated pictures into a slide. 

Offers new, dynamic slide transitions and animation effects that look 
similar to graphics you’d see on TV 

e.	 The new Microsoft Office Backstage view replaces the traditional file 
menu to let you save, share, print, and publish your presentations with 
just a few clicks

Quick Access Toolbar

Ribbon

File Tab

Text placeholder

View Buttons

Notes pane

Slide pane
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Title bar	 It is the topmost bar of the window that shows 
the name of the document.

Office button menu	 A menu button that contains the commands 
like New, Save and Open.

Quick Access Toolbar	 The toolbar that displays quick access buttons 
like Save, Undo and Redo commands.

Ribbon	 It displays the different tabs of related 
commands. Each tab has short cut buttons for 
the common tasks.

Program Window Controls	 These buttons are used to minimize the 
program window, restore the window to full 
size, or close the window.

Outline and Slides Tab	 It provides two views of the slides of your 
presentations i.e. the outline of the slide text 
and a thumbnail view of the slide.

Slide Pane	 It displays a large view of the current slide 
on the right side of the window. You can also 
enter text, graphics and animations directly in 
the slide pane.

Splitter Bar	 It allows you to adjust the width of the slide 
pane by dragging with the mouse.

Text Placeholder	 It allows you to type titles, body text and 
bulleted lists in text placeholders.

Status Bar	 The status bar consists of a message area. 
The message area displays the current slide 
number and the total number of slides in the 
slide show.

View Buttons	 It allows you to quickly change the way your 
presentation is displays on the screen. Normal 
view, slide sorter view and slide show view 
are the three main views of PowerPoint.

Notes Pane	 You can display the text notes for the current 
slide in the Notes Pane. 
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Creating a Blank Presentation with Design Theme

A theme is a predefine combination of colors, fonts, and effects that can be 
applied to your presentation. PowerPoint includes built-in themes that allow 
you to easily create professional-looking presentations without spending a 
lot of time formatting. 
To apply a theme, do the followings:
a.	 Click on the Design tab on the ribbon.
b.	 Click on one of the themes.
	 You can click on the down arrow of More button to view the full pallet 

of theme.

c.	 Hover over a theme to see a live preview of it in the presentation. The 
name of the theme will appear as you hover over it. 

d.	 Click a theme to apply it to the slides.
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About a Slide

Every PowerPoint presentation is composed of a series of slides. Slides 
contain placeholders, which are areas on the slide that are enclosed by 
dotted borders. Placeholders can contain many different items, including 
text, pictures, charts, and more. Some placeholders have placeholder text, 
or text that you can replace. They also have thumbnail-sized icons that 
represent specific commands such as Insert Picture, Insert Chart, and Insert 
Clip Art.
To insert a title slide, do the followings:
a.	 Click on the title text placeholder box.
b.	 Type your text in text placeholder box.
	 The title text, displays in the title text placeholder and in the Slides tab. 

The insertion point is displaying after the letter ‘t’ in Internet.

To enter text in subtitle, do the followings:
a.	 Click on the subtitle text placeholder box.
b.	 Type your text in subtitle text placeholder box.
	 The subtitle text is displayed in the subtitle text placeholder and the Slide 

tab. 
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Adding a New Slide to a Presentation

A presentation may contain more than one slide. After creating a slide 
the new slide can be added into the presentation. The new slide can 
contain text, graphic or charts, etc. 
To add a new slide, do the followings:
a.		 Click on Home tab on the ribbon
b.	 Click on the New Slide button.

c.	 Select the slide you want to insert.
d.	 A new slide will be added your presentation.
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Changing the Slide Layout

The PowerPoint provides the different layouts of the slide. Layouts contain 
placeholders that hold your content and place them in a regular and aligned 
format. By using layout, you can quickly change your whole presentation. 
But you need to make a few adjustments to the text position and size to fit 
the new layout, if you assign a new slide layout to the slide with existing 
text. So, it is better to assign the new layout before adding content to a slide.
To change the slide layout, do the followings:
a.	 Display the slide that you want to change.
b.	 Click on Home tab on the Ribbon.
c.	 Click on Layout button.

d.	 Click on the layout.
	 PowerPoint immediately assigns a layout to the slide. The text in the 

slide will automatically adjust itself to the new layout.
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Formatting Text

Microsoft PowerPoint’s features allow you to format slides. Readability 
and clarity are the most important design criteria that one should keep in 
mind while formatting text. Your audience should be able to read your 
presentation easily.
To change the font of the text, do the followings:
a.	 Select the text you want to change to a different font.
b.	 Click on Home tab on the ribbon.
c.	 Click on down arrow button of Font to display a list of the available 

fonts.

d.	 Click on the font you want to use.
PowerPoint immediately applies new font to the box.

To change the size of the text, do the followings:
You can increase or decrease the size of the text on a slide in PowerPoint.
a.	 Select the text you want to change to a different font size.
b.	 Click on Home tab on the ribbon.
c.	 Click on down arrow button of Font Size to display a list of the available 

sizes.
d.	 Click on the size you want to use. 
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Changing the Background Color

The background is the color, texture, pattern, or image that is applied to 
the entire slide. By its very definition, it applies to the entire surface of the 
slide; you cannot have a partial background. You can also use a picture as 
a slide background. When you change the background, you can apply the 
change to only the current slide or to all the slides.
To change the background color, do the followings:
a.	 Click on the Design tab.
b.	 Click on Background Styles.

c.	 Click on Format Background. 
	 The Format Background dialog box appears.
d.	 Click on the radio button options of Solid fill.
e.	 Click on the Color button to open a color palette.
f.	 Select the color you want to apply as a background.
g.	 Click on Close button to apply solid color on the current slide. 
	 You can click on Apply to All button to apply solid color on all the slides.
	 The color selected by you applied in the current slide.
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Adding a Clip Art on a Slide

One of the great features in PowerPoint is the ability to add graphic elements 
to the slides of the presentation. This helps to create  visually appealing 
presentations and keep the viewers entertained and interested. Clip Art is a 
library of  pictures and graphics that you can use in your presentation.
To add a Clip Art on a slide, do the followings:
a.	 Display the slide you want to add a Clip Art image to.
b.	 Change the layout of the slide to one that includes a placeholder for a 

Clip Art image.
c.	 Click on a Clip Art icon to add a Clip Art image. The Clip Art task pane 

opens.
d.	 Enter keywords in the Search for: field that are related to the image you 

wish to insert.
e.	 Click the drop-down arrow in the Results should be: field.
f.	 Click on Go.
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Inserting Screenshots

Screenshots are pictures that capture the visible windows and items 
displayed on your computer screen. They may include an open window of 
a website, items on your desktop, or an open program. These images can 
be useful for explaining or displaying computer programs, functions, and 
websites. PowerPoint allows you to capture an image of an entire window 
or a screen clipping of part of a window.
To insert screenshots of a window, do the followings:
a.	 Select the Insert tab.
b.	 Click the Screenshot command in the Images group.
c.	 The Available Windows from your desktop will appear. Select the 

window you would like to capture as a screenshot.
d.	 The screenshot will appear in your slide. 

To insert a screen clipping from a Window, do the following:
a.	 Select the Insert tab.
b.	 Click the Screenshot command and select Screen Clipping. 
c.	 A faded view of your current desktop will appear, and your cursor will 

turn into a cross shape x.
d.	 Click, hold, and drag on the area of the window that you want to capture. 
e.	 The screen clipping will appear in your slide.
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Adding WordArt and Shapes

There are many features and commands you can use in PowerPoint to create 
visually appealing slides. Two of these features are WordArt and shapes. 
PowerPoint allows you to add effects to the text inside of a text box, which 
is known as WordArt. WordArt allows the user to create stylized text with 
effects such as textures, shadows, and outlines. It can be applied to text on 
any slide. You can also insert a variety of shapes such as rectangles, circles, 
lines, arrows, callouts, and stars.
To apply a WordArt Style to text, do the followings:

a.	 Select a text box, or select some text inside of the text box. The Format 
tab will appear.

b.	 Click the Format tab.

c.	 In the WordArt Styles group, click the More drop-down arrow to view 
all of the available styles.

d.	 Select the desired style preset to apply the style to your text. 
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Animating Text and  Objects

In PowerPoint you can animate text and objects such as clip art, shapes, 
and pictures. Animation, or movement, on the slide can be used to draw the 
audience’s attention to specific content or to make the slide easier to read.
To apply an animation to an object, do the followings:
a.	 Select an object.
b.	 Click the Animations tab.
c.	 In the Animation group, click the More drop-down arrow to view the 

available animations. 

d.	 Select the desired animation effect. 

e.	 The object will now have a small number next to it to show that it has an 
animation. Also, in the Slide pane, the slide will now have a star symbol 
next to it. 
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Applying Transition

Transitions are motion effects that, when in Slide Show View, add movement 
to your slides as you advance from one slide to another. There are many 
transitions to choose from; each one allows you to control the speed and 
even add sound.
To apply a transition, do the followings:
a.	 Select the slide you wish to modify.
b.	 Click the Transitions tab.
c.	 Locate the Transition to This Slide group. By default, None is applied 

to each slide. 

d.	 Click the More drop-down arrow to display all of the transitions.
e.	 Click a transition to apply it to the selected slide. This will automatically 

preview the transition as well. 
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Presentation program	 :  	 A computer software package that 
allows you to create documents 
called presentation.  

Presentation 	 :	 A systematic display of 
information along with graphics.

Theme 	 :	 A predefined combination of 
colors, fonts, and effects that can 
be applied to your presentation.

Transitions 	 :	 The motion effects that, when 
in Slide Show View, add 
movement to your slides as 
you advance from one slide to 
another.  

Tricky Terms 

Let 
Us Revise

•	 A presentation program is a computer software package that allows you 
to create documents called presentation. 

•	 PowerPoint 2010 is a visual and graphical application, primarily used 
for creating presentations. 

•	 Allows to create presentations for lectures, research reports and meeting 
handouts

•	 A theme is a predefined combination of colors, fonts, and effects that 
can be applied to your presentation. 

•	 Slides contain placeholders, which are areas on the slide that are enclosed 
by dotted borders. 

•	 The background is the color, texture, pattern, or image that is 
applied to the entire slide.
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Slides, theme, PowerPoint, splitter bar, presentation program

a.	 A ___________________is a computer software package that allows 
you to create documents called presentation. 

b.	 ________________is a visual and graphical application, primarily used 
for creating presentations. 

c.	 ___________________allows you to adjust the width of the slide pane 
by dragging with the mouse.

d.	 A ________________ is a predefined combination of colors, fonts, and 
effects that can be applied to your presentation.

e.	 ______________contain placeholders, which are areas on the slide that 
are enclosed by dotted borders. 

2.	 Match the followings.
	 Splitter Bar	 Displays a large view of the current slide on the 

right side of the window. You can also enter text, 
graphics and animations directly in the slide pane.

	 Slide Pane	 Allows you to adjust the width of the slide pane by 
dragging with the mouse.

	 Ribbon	 Allows you to type titles, body text and bulleted 
lists in text placeholders.

	 Screenshots	 Displays the different tabs of related commands.
	 Text Placeholder 	 The pictures that capture the visible windows 

and items displayed on your computer screen. 

3.	 Say whether these sentences are True or False.
a.	 Microsoft Office PowerPoint 2010 allows you to produce professional-

looking presentations and handouts. 
b.	 Notes Pane allows you to quickly change the way your presentation is 

displays on the screen.
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c.	 PowerPoint includes built-in themes that allow you to easily create 
professional-looking presentations without spending a lot of time 
formatting. 

d.	 Screenshots are pictures that capture the visible windows and items 
displayed on your computer screen. 

e.	 Animations are motion effects that, when in Slide Show View, add 
movement to your slides as you advance from one slide to another. 

4.	 Answer the following questions.
a.	 What is a presentation program? Give examples.
b.	 What do you mean by presentation?
c.	 What is Microsoft Office PowerPoint 2010? State three advantages of 

Microsoft Office PowerPoint 2010.
d.	 What does a title slide display?
e.	 What is a theme? Write the steps to apply a theme.
f.	 What is a Clip Art? Write the steps to add a Clip Art on a slide.
g.	 What are screenshots?
h.	 What are transitions?
 

Lesson Labs

1.	 Create a new, blank presentation.
2.	 Use the Title Slide AutoLayout for the first slide. The title should read: Presenting the Internet
	 and the subtitle should read: History of the Internet.
3.	 Apply the Expedition design template to the presentation.
4.	 Add a new slide using the Bulleted List AutoLayout. The bullet slide title should read: 
	 What is the Internet 
	 Key the following as separate bullets: 
	 World Wide Web, E-Mail, Online Chatting 
5.	 Save the presentation as Internet.
6.	 Spell check, proofread and resave the presentation, and then print and close it.
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a.		 Explain how to start  QBASIC program.
b.	 Explain the elements of QBASIC programming.
c.	 Differentiate between constants and variables.
d.	 Define operator and explain the different types of operators supported by QBASIC.
e.	 Explain the function and syntax of simple QBASIC statements.

Chapter8
Basics of
QBASIC

Learning Objectives

An  Overview
The computer cannot think and make any decision on its own. It needs 
instructions to perform any task. A computer needs instructions in a 
language that it can understand. Such language is known as programming 
language. There are various types of programming languages. BASIC is one 
of the programming languages, which stands for stands for Beginners’ All 
Purpose Symbolic Instruction Code. It was developed in 1964 at Dartmouth 
College, U.S.A. by Professors John Kemeny and Thomas Kurtz. It allows 
the usage of simple English like statements and mathematical operators. 
There are various versions of BASIC like TURBO BASIC, GW-BASIC 
and QBASIC.
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QBASIC Program

QBASIC is a high level computer language developed by Microsoft in 
1985. It has a powerful pull-down menu that can be driven by keyboard or 
mouse. It can be used for scientific as well as commercial applications.
To start QBASIC program, do the followings:
a.	 Turn on the computer to load Windows Operating System and locate the 

QBASIC folder.	
b.	 Double click on the QBASIC folder.
c.	 Double on the QBASIC icon. 
Now you are presented with a welcome screen. Press Esc to clear the dialog 
box. The main QBASIC window appears. The QBASIC window is available 
for you to enter a program and execute it. The QBASIC window has the 
following parts: Menu bar, Edit window, Immediate window, Status bar. 

Tips Corner

High level language is a computer programming language that resembles natural language or mathematical 
notation and is designed to reflect the requirements of a problem. It is specially used for solving mathematical 
and statistical problems. Today, there are dozens of high-level languages; some examples include BASIC, C, 
FORTRAN, Java, and Pascal.

Menu bar

Edit Window

Immediate Window
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Format of QBASIC Statements

Every command or instruction in QBASIC is called a statement. These 
statements or instructions should be given according to the rules of the 
language in which the program is written. The way in which a particular 
statement should be written is called the syntax of the statement.
All QBASIC program lines have the following syntax:	
[line-identifier][statement][:statement]...[comment]
Where,
Line identifier	 A line in BASIC may have one line-identifier. BASIC 

supports two types of line-identifiers. They are line 
numbers and alphanumeric line labels. 

My First Program
The central part of QBASIC’s development environment is the powerful 
and intelligent full screen editor. It allows you to write programs, view files 
and execute the programs.
Type the following program in the programming window.	

Now, press F5 to execute the program. 
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Elements of QBASIC Programming

The important elements of QBASIC programming consists of the character 
set, variables, constants, operators, expressions keywords.

Character Set
The character set is a set of symbols used to frame the various components of 
a program. The character set consists of digits, letters and special characters 
that are valid in QBASIC. The character set includes:
Alphabets	 :	 A to Z (small and capital letters)
Numbers	 :	 0 to 9
Special	 :	 ;  = + -* / ^ ( ) % $ #! ,
characters	 :	 .’ “ :& ? < > \ - b 
			   (Note: The symbol b denotes a blank space.)
Variables
Variables are programmer-defined areas in the computer memory for storing 
data. When programmers talk of computer memory, it is usually RAM to 
which they are referring. All variables are created in RAM. The data stored 
in a variable can change during the execution of the program.

Variable-Naming Conventions
Variable names need to follow certain rules and standard naming conventions 
of QBASIC. Given below are certain points to remember when naming a 
variable:	
•	 The names may be up to 40 characters long.
•	 The characters allowed in a variable names are letters, numbers, the 

decimal point and the special type declaration characters ($, %, #, &, 
and !).

•	 The first character in the variable name must be a letter.
•	 Reserved words of QBASIC cannot be used as variable names.

Types of Variable	
Variables are of two types - numeric variable and string variable depending 
on the kind of data item they represent.
•		 Numeric Variable
		 A numeric variable has a number as its value. It must begin with an 

alphabet and the remaining characters, if used, may be alphabets or 
digits or both. The valid numeric variables are A2 and B.	
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Solved Example

A = 20	 ‘A is a numeric variable and 20 is a numeric constant”
PRINT A	
END

•	 String Variable
	 The string variable has a character or string of characters as its value. 

It must begin with an alphabet and end with a dollar($) sign. The valid 
string variables are A$, B3$, C$ and TL$.	

Solved Example

REM “The program to input and display the name and address of person”
CLS
INPUT “enter the name”; n$
INPUT “enter the address”; add$
PRINT “ Your name is:::”;n$
PRINT “ Your address is :::”;add$
END

Constants
Constants are data items whose values do not change while the program 
is running. There are two types of constants: numeric constant and string 
constant.  
•	 Numeric Constant
	 Numeric constants are positive or negative numbers on which 

mathematical operations such as addition, subtraction, multiplication 
and division can be performed. Numeric constants should not contain 
commas. The valid numeric constants are 150, -980, +76 and 129.

•	 String Constant
	 A string constant is a set of alphanumeric or special characters enclosed 

within double quotes. Blank spaces can also be used in a string. The 
valid string constants are “Fun with BASIC” and “Enjoy Programming”.
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Operator
An operator is a symbol representing the operations they perform on operands 
in a program. The values on which the operator’s work are referred to as 
operands. It is used to compute, compare values and test multiple conditions. 
The operators in QBASIC are classified as follows:
a. 	 Arithmetic operators	 b.  Relational operators
c. 	 Logical operators	 d.  String operator

a.		 Arithmetic Operators
		 Arithmetic operators are used to perform various mathematical operations.  

The general format of arithmetic operator is:	  
	 operand1 arithmetic_operator operand2 
	 The arithmetic operators supported by QBASIC are: 
	 Operator	  Name	 Example
	 +	 Addition	 A + B
	 -	 Subtraction	 A - B	
	 *	 Multiplication	 A*B	
	 /	 Division	 A/B
	 \	 Integer Division	 A\B
	 Mod	 Modulus	 A mod B
	 ^ 	 Exponential	 A^B

Solved Example

REM “The program to illustrate the use of arithmetic operators”
a = 15 : b = 5
PRINT “The difference is=”;a-b
PRINT “The sum is=”;a+b
PRINT “The product is= “;a*b
PRINT “The quotient is= “a/b
END
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b.	 Relational Operators
		 Relational operators are used to compare two values of same type, either 

both numeric or both string. The general format of relational operator is: 
	 operand1 relational_operator operand2
	 The relational operators supported by QBASIC are:
	 Operator	  Name		  Example
	 =	 Equal		  A=B
	 <	 Less than		  A<B
	 >	 Greater than		  A>B
	 <=	 Less than or equal to		  A<=B
	 >=	 Greater than or equal to	 A>=B
	 <>	 Not equal to		  A<>B

b.	 Logical Operators
	 Logical operators are used to connect two or more relational expressions 

to evaluate a single value as True or False. The general format of logical 
operator is:

	 operand1 logical_operator operand2
	 The logical operators supported by QBASIC are:
	 Operator	  Name			   Example
	 AND	 Evaluates to true when both		  A > B AND
			  conditions are true			   A > C
	 OR	 Evaluates to true when one		  A > B
			  or both conditions are true		  OR  A > C
	 NOT	 Makes a true expression false, 	 A  NOT  B
			  and a false expression true.
Solved Example

Assume  x=5 and y=6. What will be stored in result in each of the 
following statements?
Expression	 Result
(x<7) AND (y>7)	 True AND False => False
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a.		 String Operator
	 The joining of two or more strings is called concatenation of strings. The 

strings are connected by the string operator, which is the plus sign (+). 
For example, the statement:

	 PRINT “KATH” + “MANDU”
	 would cause QBASIC to display the following string.	
	 KATHMANDU

First Look at QBASIC statements

A statement is a group of BASIC keywords generally used in program lines 
as part of a program. These statements are first stored in the memory of 
the computer and executed only when the command RUN is given. It is 
either executable or non-executable. Executable statements are program 
instructions that tell BASIC what to do during the execution of a program. 
Non-executable statements do not cause any program action. In this section, 
we shall discuss simple programming statements.
REM statement
The REM statement is the short form of ‘remarks’. The computer ignores 
anything following the word REM and it is used to put explanatory notes 
in the program. You may use a single quotation mark ( ‘ ) instead of REM. 
The general form of the REM statement is: 

Brainstorming 

  task
Circle the best suitable answer.
a.	 Every command or instruction in QBASIC is called a……
	 i.	 Constant        	 ii. Line      		  iii. Statement
b.	 Character set consists of ………………….
	 i.	 Digits			  ii. Letter		  iii. Both
c.	 The example of Arithmetic operator is…………..
	 i.	 Addition(+)    	  ii. Equal(=)      	 iii. None of them
d.	  The REM ids the short form of………………..
	 i.	 Remarks		  ii. Reload       	  iii. Clear
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REM <Any Text>

REM  “My first QBASIC program”
LET price = 200
LET tax = price * 25 / 100
PRINT “The sales tax is::”; tax
END

CLS statement
The CLS statement clears the screen. It is used whenever a fresh screen is 
desired during the program execution. The general form of the CLS statement 
is: 
CLS

Solved Example

CLS
PRINT “Programming is great fun”
END

LET statement
The LET statement is used for storing a value in a variable. The word LET is 
optional, i.e., the equal to sign is sufficient when assigning an expression to a 
variable name. The general form of the LET statement is:			     
LET <variable> = <variable or constant or expression>

Solved Example

REM “Program to find the sum of two numbers”
LET a = 20
LET b = 30
Sum = a + b
PRINT “The sum of the two numbers::: “; Sum
END
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INPUT statement
The INPUT statement is used to accept input from the keyboard during 
program execution. It facilitates the use of same program for various sets of 
data to obtain different results in different executions. The general form of 
the INPUT statement is:	
INPUT <“message”> ; variables

Solved Example

REM “This program finds the volume of a room” CLS 
INPUT “Enter the length of a room”; l 
INPUT “Enter the breadth of a room”; b
INPUT “Enter the height of a room”; h
 vol = l * b*h
PRINT “The volume of room is:::”; vol 
END

PRINT statement
The PRINT statement is used to display data or the results of calculation on 
the screen. Question mark (?) may be used in place of the word ‘PRINT’. 
The general form of the PRINT statement is:	
PRINT <variable, constants or expressions> 
Print Positions
BASIC divides the line into print zones of 14 spaces. The position of each 
item displayed on the screen is determined by the punctuation used to separate 
the items in the list. The separator and print position is described below: 
Separator		  Print Position
	 ,		  Zone wise 	
	 ;		  Side by side
	 space(s)	 Immediately after the last value	
END statement
The END statement denotes the end of the program. Once the program 
encounters the END statement, the computer stops processing any further as 
it has reached the termination point. It must be written as the last statement 
in every program. The general form of the END statement is: 
END
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QBASIC	 :  	 A high level computer language 
developed by Microsoft in 1985.

Character set	 :	 A set of symbols used to frame 
the various components of a 
program.  

Variables 	 :	 The programmer-defined areas in 
the computer memory for storing 
data.  

Constants	 :	 The data items whose values do 
not change while the program is 
running. 	

Operator	 :	 A symbol representing the 
operations they perform on 
operands in a program. 

Tricky Terms 

Let 
Us Revise

•	 QBASIC is a high level computer language developed by Microsoft in 
1985. 

•	 The character set is a set of symbols used to frame the various components 
of a program. 

•	 Variables are programmer-defined areas in the computer memory for 
storing data.

•	 Constants are data items whose values do not change while the program 
is running.

•	 An operator is a symbol representing the operations they perform on 
operands in a program. 

•	 The joining of two or more strings is called concatenation of strings.
•	 A statement is a group of BASIC keywords generally used in program 

lines as part of a program. 
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Solved  Exercise

A.	 Write a program that calculates the sum of two numbers.

Program code: Output screen

cls

input “enter the first 

number”;A

input “enter the second 

number”;B

sum=A+B

print “the sum of two 

number is”;sum

end

B.	 Write a program that calculates the area of rectangle.

Program code: Output screen

CLS

INPUT “enter the length of 

rectangle”;L

INPUT “enter the breadth 

of rectangle”;B

A = L * B

PRINT “The area of a 

rectangle is”;A

END
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C.	 Write a basic program to input the  height and base and find out the 
area of triangle.

Program code: Output screen

CLS

INPUT “enter the 

height”;H

INPUT “ente the 

breadth”;B

area = 1 / 2 * (H * B)

PRINT “The area of 

triangle is”; area

END

D.	 Write a program that converts centigrade temperature into Fahrenheit 
temperature. Where F=(9/5)*c+32.

Program code: Output screen

CLS

INPUT “enter the 

tempreature in 

centigrade”;c

F = C * (9 / 5) + 32

PRINT “The tempreature 

in fahrenheit is”;F

END
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E.	 Write a program to calculate the simple interest.

Program code: Output screen

CLS

INPUT “ente the 

principle”;p

INPUT “enter the rate”;r

INPUT “enter the time”;t

si = (P * T * R) / 100

PRINT “The simple 

interest is”;si

END

F.	 Write a program to print your name, address, age, class.
Program code: Output screen

cls

input “enter your name”;n$

input 

enter “your address”;a$

input “enter your age”;age

input “enter your class”;c

print “Your name is ::::”;n$

print “Your address is ::::”;a$

print “Your age is ::::”;age

print “Your class is ::::”;c

end
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
END, QBASIC, Constants, concatenation, PRINT

a.	 ______________ is a high level computer language developed by 
Microsoft in 1985.

b.	 ______________ are data items whose values do not change while the 
program is running.

c.	 The joining of two or more string is called ______________ of string.
d.	 The ______________ Statements is used to display data.
e.	 The ______________ statements denotes the end of the program.

2.	 Match the followings.
	 INPUT	 To display data from the computer system
	 CLS	 To input data to the computer
	 PRINT	 To clear the screen
	 Variable		 End of a program
	 Constant	 The value can be change
	 END                  	 The value cannot be change

	
3.	 Say whether these sentences are True or False.
a.	 BASIC allows the usage of simple English like statements and 

mathematical operators. 
b.	 The numeric variable must begin with a number and the remaining 

characters, if used, may be alphabets or digits or both. 
c.	 Reserved words of QBASIC cannot be used as variable names.
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d.	 The string constant is a set of alphanumeric or special characters enclosed 
within single quotes.

e.	 Operator is a symbol representing the operations they perform on 
operands in a program. 

4.	 Answer the following questions.
a.	 What is a BASIC program?  Who developed BASIC?	
b.	 What are the important elements of QBASIC programming language?
c.	 What are variables and constants?
d.	 Differentiate between a numeric variable and a string variable.
e.	 What are operators? State the rules of logical operators.

5.	 Write BASIC expressions for the following algebraic expressions:
a.	 y = 6x			   b.  a = 2b+5c		  c.  y = x2 

d.	 nr2  + KT		  e.  (F - 32)2 			   f.  a2  + b2 

6.	 Let x = 5, y = 8 and z = 10. What will be the value stored in result in each 
of the following statements?

a.	 r = x + y - z
b.	 r = (x * y) MOD z
c.	 r = z*y/x
d.	 r = (x+y)/z
e.	 r = (y/x)*z 

7.	 Examine the following program.
	 a = 2
	 b = 3000
	 PRINT “The first number is “;a
	 PRINT “The second number is “;b
	 END
	 List all the variables and constants that appear in the above program.
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8.	 Answer the following questions.
a.	 Write a program that stores the integers 52 and 87 in two variables and 

store the sum of these two integers in a variable named total.
b.	 Write a program to input two numbers (25 and 2) and print their quotient 

and remainder.
c.	 Write a program that displays the following information, each on a 

separate line:
	 Your name			   Your address
	 Your telephone number	 Your school’s name
d.	 Write a program to input the side of a cube. Print the volume and the total 

surface area. (Hint :Volume of Cube =  Length ̂  3 and Total Surface area 
= 6 * Length ^ 2)

e.	 Write a program to find the area of the four walls of a room. (Hint: Area 
= (2 * (length + breadth)) * height)

Lesson Labs

1.		 The cost of an item is Rs 200. What will be the cost of 50 such items. Write a simple program.
2.	 The sales tax on an article is 25% of its price. Write a program to find the sales tax on an article priced at 

Rs. 10000.
3.	 The computer lab is 20 m long, 15 m wide and 24 m high. Write a program to find the cost of painting its 

four walls at Rs. 43 per square metre. (Area of four walls = 2h(l +b).
4.	 Write a program to find the volume of a box.
5.	 Write a program to compute the area and circumference of a circle. 
6.	 Ram has deposited Rs. 2000 in Bank at the rate of  2% per year. Write a program to find how much interest 

will he be getting after 3 years?
7.	 Rajesh is a shopkeeper. He has bought 2 dozen pencils for Rs. 90 and sold them at the rate of Rs. 2. Write 

a program to find the profit that he has earned. 
8.	 Manish has been assigned to write a program in which one can input a number and find out whether it is 

divisible by 5. Can you help him with the task?
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Ty
ps

ha
la

Introduction

Touch typing is a commonly used system, which enables you to 
type quickly and accurately without looking at the keys. In order to 
know where your fingers are without looking, you must keep them 
positioned over their home keys, in the middle row of the keyboard.
Typshala is a typing tutor that provides free hand typing and entertains 
the user with a game.
To start typshala, follow these steps:
a. 	 Click on Start.
b. 	 Click on Typshala. Typshala program appears on the screen.
c.	 Click on Home.
d.	 Choose ‘Level 1’. 
e.	 Click on OK.
f.	 Choose writing script. 
g.	 Start typing.
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Lesson Exercise 1
a.	 Choose English Script from the Options menu.
b.	 Choose Lessons | Home Row | Level 1. Now, start typing
	

c.	 Choose Lessons | Home Row | Level 2. 

d.	 Choose Lessons | Home Row | Level 3. 
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Lesson Exercise 2
a.	 Choose English Script from the Options menu.
b.	 Choose Lessons | Top Row with Home Row | Level 1. Now, start typing
	

c.	 Choose Lessons | Top Row with Home Row | Level 2 

d.	 Choose Lessons | Top Row with Home Row | Level 3
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Lesson Exercise 3
a.	 Choose English Script from the Options menu.
b.	 Choose Lessons | Bottom Row with Home Row | Level 1. Now, start typing
	

c.	 Choose Lessons | Top Row with Home Row | Level 2 

d.	 Choose Lessons | Top Row with Home Row | Level 3




